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Chapter 1 Introduction

Chapter 1 Introduction

About this manual

This manual has been written to help users of Freeway Pro to integrate
Sitelok in their projects. It is not meant to replace the main Sitelok Manual
but really to explain Freeway specific points. We assume that you have
installed Sitelok on your server already and that it is working properly.

As Sitelok uses PHP you won't be able to test the functionality of your
pages within Freeway. You must publish you site to test the pages.

Please note that Sitelok normally requires pages to have the php
extension. To do this just name your page with .php instead of .html in
the page inspector.
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Chapter 2 Securing a members page
Securing a page

Sitelok can secure .php pages on your site by simply adding a code snippet
to the very top of the the page telling Sitelok which usergroups have
access.

First of all create the page you want to secure. To secure it select HTML
Markup... from the Page menu. Choose Before <html> as the Insert option
and enter the following code in the box.

<?php
$groupswithaccess="CLIENT";
require_once("../slpw/sitelokpw.php");
>

This tells Sitelok to only allow access to members of the CLIENT
usergroup. You can replace CLIENT with another group name or list
multiple groups separated by commas.

Please note that the above code assumes that your page is in a folder. If it
is in the root of your site then we need to adjust the relative path so use

require_once("slpw/sitelokpw.php");

0.0.6 Markup

Insert: | Before <html> N

<?php

Sgroupswithaccess="CLIENT";
require_once("../slpw/sitelokpw.php™);
>

Use Master Settings Cancel ' OK ]
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Adding a logout link
You can add a logout link to your site by creating a hyperlink that points to
<?php siteloklogout()?>

To do this just highlight the text or object you want to turn into a hyperlink
and click Hyperlink... in the Edit menu.

Click the External tab and choose Other as the protocol. Enter the following
code in to the box.

<?php siteloklogout()?>

Edit Hyperlink

Protocol: | Other 4+ | Quick Links: | &

<?php siteloklogout(); 7>

| Browse... | | Check... |

Title: |Logout | Extended...
Target: [ v
Access Key:

Remove Link | | Cancel | OK
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Displaying user data in pages

Sitelok lets you display any data stored in the users record anywhere on the
page. So for example you might like to display the users first name or email
address. To do this simply use any of the following codes as required.

First name
Last name
Full name
Email
Username
Custom1

The easiest way to insert these codes in the page is to click the Markup
Item... option in the Insert menu. You can then paste in the code needed

<?php echo $slfirstname; 7>

<?php echo $sllastname; ?>

<?php echo $slname; ?>

<?php echo $slemail; ?>

<?php echo $slusername; ?>

<?php echo $slcustom1; ?>

for other custom fields replace the 1 in the code.

and then position it on the page.

HTML Markup

<?php echo $slfirstname; 7>/

| Cancel | OK
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Chapter 3 Registration page

A registration page is used to allow users to register for free access to your
members area. If you are selling membership using a payment plugin (such
as the Paypal or 2checkout plugins) then you have to use a registration
form as the user is added automatically after payment.

To create a registration form follow these steps
Creating the form

In the Sitelok control panel go to Forms - Registration forms. Here you can
either use an existing form or create a new one. The form designer allows
you to design and style the form as well as setting things like the usergroup
to add the user to, the thankyou page and also the email to be sent out.
When the form is how you want it click Save.

Although its usually straightforward the main Sitelok manual explains how
to use the designer in more detail.

It's also possible to write your own form code to use with Sitelok if you need
to. The main Sitelok manual explains how to do that.

Add the form to your page

To generate the code to add to your page click = next to the form.

There are a few options for the generated code but unless you need to
make custom changes to the form code you can just leave the defaults to
embed the form in your page. You will see the 3 steps to adding the code to
your page as follows.

Step 1

Copy the code to the clipboard and then in Freeway select HTML Markup...
from the Page menu. Choose Before <html> as the Insert option and paste
in the clipboard contents.
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0.0.06 Markup

Insert: | Before <html> s

| Use Master Settings | | Cancel | OK

Step 2

Copy the code to clipboard and then in Freeway select HTML Markup...
from the Page menu. Choose Before </head> as the Insert option and
paste in the clipboard contents.

0.0.06 Markup

Insert: | Before </head> s

| Use Master Settings | | Cancel | OK

Step 3

Copy the code to clipboard and then in Freeway decide where you want the
form to appear on the page. Select Insert - Markup Item... and paste in the
clipboard contents.
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0.0 .06 HTML MarkUp

| Cancel [ oK ]

When you publish the page you should see the form appear. As the form
was embedded in the page any changes you make to the design in Sitelok
should appear on the page immediately when saved without needing to
publish the page again.
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Chapter 4 Update profile page

An update profile page allows the user to modify details that you store
about them such as their password and email address.

To create an update form follow these steps
Creating the form

In the Sitelok control panel go to Forms - Update profile forms. Here you
can either use an existing form or create a new one. The form designer
allows you to design and style the form as well as setting an optional
thankyou page and emails to be sent. When the form is how you want it
click Save.

Although its usually straightforward the main Sitelok manual explains how
to use the designer in more detail.

It's also possible to write your own form code to use with Sitelok if you need
to. The main Sitelok manual explains how to do that.

Add the form to your page
To generate the code to add to your page click = next to the form.

There are a few options for the generated code but unless you need to
make custom changes to the form code you can just leave the defaults to
embed the form in your page. You will see the 3 steps to adding the code to
your page as follows.

Step 1

Copy the code to the clipboard and then in Freeway select HTML Markup...
from the Page menu. Choose Before <html> as the Insert option and paste
in the clipboard contents.
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0.0.06 Markup

Insert: | Before <html> s

| Use Master Settings | | Cancel | OK

Step 2

Copy the code to clipboard and then in Freeway select HTML Markup...
from the Page menu. Choose Before </head> as the Insert option and
paste in the clipboard contents.

0.0.06 Markup

Insert: | Before </head> s

| Use Master Settings | | Cancel | OK

Step 3

Copy the code to clipboard and then in Freeway decide where you want the
form to appear on the page. Select Insert - Markup Item... and paste in the
clipboard contents.
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0.0 .06 HTML MarkUp

| Cancel [ oK ]

When you publish the page you should see the form appear. As the form
was embedded in the page any changes you make to the design in Sitelok
should appear on the page immediately when saved without needing to
publish the page again.
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Chapter 5 Download links

Sitelok can secure download links as well making sure that the location of
the files on your server is not known and that they only worked for logged in
users.

Storing your files
If you want to secure downloads using Sitelok you should store the files in
the file folder created during installation. This will have a name like

slfiles_xxxx and won't be found by search engines, robots or hackers. You
can find the folder name in Tools - Configuration - Download paths.

Creating a download link

You can add a download link in your page by creating a hyperlink that
points to

<?php siteloklink('testfile.zip',1); 7>

To do this just highlight the text or object you want to turn into a hyperlink
and click Hyperlink... in the Edit menu.

Edit Hyperlink

Internal

Protocol: = Other 4 Quick Links:

<?php siteloklink('testfile.zip',1); 7>

Browse... Check...

Title: Extended...
Target: v

Access Key:

Cancel | | OK |
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Click the External tab and choose Other as the protocol. Enter the following
code in to the box.

<?php siteloklink('testfile.zip',1); ?>

Replacing testfile.zip with your filename (no path needed)
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Chapter 6 Pages with login forms

Sitelok has two ways for users to login. The simplest is the login form (login
template) that appears if a user tries to visit a secured page and haven't yet
logged in. The default login form that appears can be styled in Forms -
Default Login form style or can be replaced by your own custom login
template (see the main Sitelok manual for details).

Often the default login form is all that is needed as you can create a login
link on your site that simply links to a secured page to force the login form
to appear when necessary. However in some cases you may prefer to have
a login form on one or more of your pages and this can be done as follows.

Creating the form

In the Sitelok control panel go to Forms - Login forms. Here you can either
use an existing form or create a new one. The form designer allows you to
design and style the form as well as setting optional features such as
captcha and forgotten password.. When the form is how you want it click
Save.

Although its usually straightforward the main Sitelok manual explains how
to use the designer in more detail.

It's also possible to write your own form code to use with Sitelok if you need
to. The main Sitelok manual explains how to do that.

Add the form to your page

To generate the code to add to your page click = next to the form.

There are a few options for the generated code but unless you need to
make custom changes to the form code you can just leave the defaults to
embed the form in your page. You can decide if you want users to be
redirected on login (if their usergroup has a redirect URL set) or to stay on
the page. You can also set if you want the login form to be hidden when the
user is logged in.

Step 1

Copy the code to the clipboard and then in Freeway select HTML Markup...
from the Page menu. Choose Before <html> as the Insert option and paste
in the clipboard contents.
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0.0.06 Markup

Insert: | Before <html> s

| Use Master Settings | | Cancel | OK

Step 2

Copy the code to clipboard and then in Freeway select HTML Markup...
from the Page menu. Choose Before </head> as the Insert option and
paste in the clipboard contents.

0.0.06 Markup

Insert: | Before </head> s

| Use Master Settings | | Cancel | OK

Step 3

Copy the code to clipboard and then in Freeway decide where you want the
form to appear on the page. Select Insert - Markup Item... and paste in the
clipboard contents.
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0.0 .06 HTML MarkUp

| Cancel [ oK ]

When you publish the page you should see the form appear. As the form
was embedded in the page any changes you make to the design in Sitelok
should appear on the page immediately when saved without needing to
publish the page again.
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Chapter 7 Support

Hopefully if you have followed this manual carefully everything will be
working fine. However sometimes things don’t go quite so smoothly so if
you have any questions or problems then please check the FAQ on the
support page or email us.

Support and updates for Sitelok are free of charge for one year after
purchase. Shortly after purchase you should receive a username and

password that provide you with access to the latest downloads, FAQ and
other resources.

Support area: http://www.vibralogix.com/support/

Email: support@vibralogix.com
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